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Adobe Photoshop  dasturida tasvirga ishlov berish. Qatlamlar  bilan ishlash. 

 

1. Adobe Photoshop 7.0 Programmasi bilan tanishuv 

2. Qatlamlar xaqida tushuncha va yangi qatlam yaratish. 

3. Xosil qilingan qatlam ustida bir nechta ammalar bajarish. 

4. Xosil qilingan hamma qatlamlarni o’chirib tashlash.  



 

 

 

Adobe Photoshop 7.0 Programmasi bilan tanishuv 

 

Programmani ishga tushirish: Windows 95, 98, ME, 2000, XR ili NT operatsion 

sistemasida ke Start (Pusk) tugmasiga bosing paneli zadach bo’limida joylashgan 

Programs (Programmy) bo’limiga kiring so’ngra Adobe, Photoshop 7.0 ichidagi  

Adobe Photoshop 7.0 elementi ustiga sichqoncha bilan bosing . Adobe 

Photoshop 7 programmasi mavsum programmalar orasida   superxit produktga 

aylandi. Uni ustiga bu programmaning xar bir soni  o’zida yangi elementlarni 

mujassamlashtirgan. Bu o’zgarishlar Photoshop 07 versiyasida xam kuzatiladi. 

Ishlab chiqaruvchilar bu programmadagi bir qator kamchiliklarni bartaraf qilishdi , 

bularga Windows i Mac OS X. Qismida , Photoshop 7 nixoyat virtual xotira 

sistemasini ishlaishni o’gandi , natijada Operativ xotiraning bir qancha qismi tejab 

qolindi. Bu tejmkorlik kata xajimga ega bo’lgan  tasvirlar Bilan ishlaganda 

seziladi. Shuningdek operatsion sistemani osilib qolishi kamaydi. Xozirda  

Photoshop boshqa bir qancha daturlar Bilan bir vaqtda yaxshi ishlashi mumkun. 

 



Ras  Photoshop 7 ekran ko’rinishi. 

Rasmda Photoshop programmasida ishlash payti ko’rsatilgan. (1) tugmasi bosib 

boshqaruv menyusi ishga tushiriladi. U o’zida quydagi buyruqlar (komanda)larni 

mujassamlashtirgan: Restore (Qayta tiklash(Vosstanovit)), Move 

(Siljitish(Peremestit)), Size (Ulchami(Razmer)), Minimize (Pastga 

tushirish(Svernut)), Maximize (Ochish(Razvernut)) va Close (Yopish(Zakryt)). (7) 

tugmasi yordamida xujjatni boshqarish menyusi ishga tushiriladi. Asosiy menyuda 

quydagicha komandalar mavjud: Restore (Vosstanovit), Move (Peremestit), Size 

(Razmer), Minimize (Svernut), Maximize (Razvernut), Close (Zakryt) va Next 

(Кeyngi(Sleduyuщiy)).  

 

      Photoshop va ImageReady programmalariga tasvirni tez ko’rib chiqish  moduli 

kiritilgan. Oldin esa bu ishni amalga oshirish uchun tashqi programma(utilit)lar 

ishlatilardi masalan ACDSee yoki ThumbsPlus. (PDA) chuntak kompyuterlari 

uchun rasimni importi va eksporti WBMP formatli filtrlari kiritilgan.  

Кompyuterning ishlash chegarasi doirasida avtomatik tarzda rasmning sifatini 

buzmagan xolda moslashuv(optimizatsiya)ni bajaradi. 

Photoshop 7 programmasiga gurux(gruppovoy) bo’lib ishlash uchun qushimcha 

imkoniyatlar kiritildi. Bu bir kompyuterda turli foydalanuchilar tominidan Adobe 

programmasida ishlash imkoniyatini beradigan AfterCast kengaytkich qushildi. 

Agar bir foydalanuvchi tasvirga o’zgartirish kiritsa bir vaktni o’zida xama 

foydalanuvchilar kuzata oladi. Ammo AfterCast sozlash(nastroyka)ni fakat 

administrator boshqara oladi, lekin bu o’z uy kompyuterlarida Photoshop 

programmasida ishlovchi foydalanuvchilar bu muammoga duch kelmaydilar. Biz 

yuqorida faqatgina Photoshop 7ni asosiy imkoniyatlarini sanab chiqdik. 

Asboblar paneli(panel instrumentov) 

        Ekranda turgan programma asboblarini ishga tushirish uchun sichkoncha Bilan 

uniustiga bosing va ekranda kurinayotgan piktogrammani ustiga bosing. Bir xil 

piktogrammalar yonida kichik kursatkich(strelochka)lar mavjud. Agar uni ustiga 

bosilsa tasvirga tugri keluvchi oyna(palitra)lar ko’rsatiladi, u erdan siz kerakli 



asboblarni 

tanlashingiz mumkin. Xar bir asbob uchun o’zining o’lcham(parametr)lari ekran 

teppasida joylashgan optsiyalar panelida mavjuddir (masalan, rejim smeshivaniya, 

znachenie neprozrachnosti) . 

 

 

Rasm. 2. asboblar panelida paydo buluvchi maslaxat(podskazka) oynasi 

Eslatma :Edit > Preferences > Display& Cursors (Pravka > Ustanovki > 

Otobrajenie&kursory) oynasida kursor va asboblar  piktogrammalari 

ko’rinishlarini so’zlash mumkun.  

Optsiyalar paneli (Panel optsiy)  

Optsiyalar paneli xar bir asbobning parametorlarini sozlash uchun 

ishlariladi(masalan, shaffoflik darajasi yoki tasvirni aralashtirish rijimini) -  3 rasm 

. Optsiyalar panelining ung tomonida maxsus ranglarni saqlovchi bulim mavjuddir. 

Parametrlarni ko’ursatilishi qaysi rasmni tanlanganiga bog’liq(3-8 rasm). 

Foydalanuvchi tomonidan kiritilgan tasvir ko’rinishi  boshqa o’zgartirishlar 

kiritilguncha saqlanadi. Palitra va optsiyalar panelini xam ekranni istalgan joyga 

siljitish mumkin.  

 
Rasm. 3. Brush asbobi uchun optsiyalar paneli   

 
Rasm. 4. Rectangular Marquee asbobi uchun optsiyalar paneli   

 

 
Rasm. 5. Gradient asbobi uchun optsiyalar paneli    

 
Rasm. 6. Rep asbobi uchun optsiyalar paneli    

 
Rasm. 7. Rectangle asbobi uchun optsiyalar paneli    



 
Rasm. 8. Ture asbobi uchun optsiyalar paneli    

Eslatma:  Edit > Preferences > Display& Cursors (Pravka > Ustanovki > 

Otobrajenie&kursory) oynasida kursor va asboblar panelidagi asbob 

piktogrammasini tanlashingiz mumkun. 

  NaOptsiyalar panelining o’ng tomonida aktiv asbob piktogrammasi ko’rsatilgan. 

Agar piktogramma yonidagi  strelka ustiga bosilsa , ko’rinmay turgan menyu 

ochiladi, unda boshqa kerakli bo’lgan asbobni tanlash mumkun. Bu jadvalga 

uzgartirishlar kiritish mumkun yani kam ishlatilayotgan asboblarni olib tashlab 

urniga kerakli bo’lgan asboblarni joylash mumkun. Xar bir  optsiyalar paneliga 

kiritilgan uzgartirishlar avtomatik tarzda saqlanib qolinadi. Tugmalarni qayta 

tiklash va joylashtirish uchun paydo bo’luvchi paneldan amalga oshiriladi. 

Paydo buluvchi yordamchi maslaxatlar(vsplyvayuщie podskazki)  

Istalgan piktogramma ustiga sichqonchani bosmasdan olib boring shunda siz 

ishlatmoqsi bo’lgan asbobning nomi va uni klaviatura orkali ishga tushiradigan 

tugmachalar ko’rsatiladi. Shu bilan bir qatorda ishlatilayotgan optsiyalar oynasi va 

uning vazifasi xaqida qisqacha malumot olish mumkin (9 rasm). Edit > 

Preferences > General (Pravka > Ustanovki > Obщie) oynasidagi yordamchi 

maslaxtlar oynasini ishlatish uchun Show Tool Tips oynasi ustiga bayroqchani 

o’rnating (Pokazivat ispravlayushie podskazki)   

 
Rasm. 9. Optsiyalar panelidagi yordamchi maslaxatlar 

Programmaning barcha komandalari uchun Asosiy menyu (Glavnoe menyu) 

mavjuddir: 

 
Rasm. 10. Asosiy menyu 

File (Fayl) menyusi quydagi xolatlarda ishlatiladi: yaratish(sozdat), 

ochish(otkryt), joylashtirish(razmestit), yopish(zakryt), saklash(soxranit), 

skanirlash(otskanirovat), import va eksport, kog’ozga chiqarish(napechatat 



izobrajenie), Faylni tarmoq orqali o’zatish(peredat fayl po seti), bir nechta 

optsiyalarni avtomatlashtirish uchun va albatta Photoshop dasturidan chikish 

uchun. 

Edit (Pravka) menyusida, tasvirni redaktirlash yani sozlash uchun komandalar: 

nusxalash(kopirovaniya), o’zgartirish(transformatsii), joylashtirish va tasvir 

ranglarini tusini va muyqalam qalinligi va turini tanlash mumkin. 

Mode (Rejim) menyuosi orqali Image (Izobrajenie) menyusi, tasvir sakkiz 

turdagi  tasvir urinishlarini tanlash mumkin. 

Layer (Sloy) menyusida joylashgan komandalar, bir necha qatlamlardan 

joylashgan tasvir ustidagi amallar yani: qatlamlar aro bog’lanishni qatlamlar ketma 

ketligini va qatlamlarni umumiy qatlamga birlashtirish imkoniyatini beradi. 

Select (Vydelit) menyusida joylashgan komandalar – kerakli qatlamlarni 

tanlashda ishlatiladi. 

Filter (Filtr) menyusi o’zida tasvirlarni birlashtirish va umumiy xolga keltirish 

uchun kerakli bo’lgan filtiri mavjuddir. 

View (Vid)menyusidagi komandalar, ekrandagi tasvirni ko’rinishlarini nazorat 

qiladi. 

Window (Okno) menyusi komandalari, ekrandagi boshqa tasvirlarni aks 

ettiradi va ulardan kerakli bo’lgan paytda foydalanish imkonini beradi. 

Help (Pomosh) menyusidagi komandalar foydalanuvchi uchun kerakli bo’lgan 

maslaxatlar orqali ko’mak va xozirda bajarish mumkun bo’lgan imkoniyatlar bilan 

tanishtiradi xamda Photoshop ihtiyoriy saytiga murojat qilsh imkoniyatini beradi.  

Istalgan tasvirni xoxlagan paytda uzgartirishlar kiritish imkonini va 12 turdagi 

Photoshop kengaytma(format)larida saqlash imkonini beradi. Ammo odatta asosiy 

kuydagi Photoshop formatlari ishlatilad: TIFF, GIF, JPEG, EPS. 

Photoshop programmasida ko’pgina operatsiyalar asosan politralar orqali 

bajariladi. Ekranda ko’p joy egalamasligi uchun politralar o’zaro guruxlarga 

biriktirilgan: Navigator/Info (Boshkaruv/Informatsiya), Color/Swatches/ Styles 

(Rang/Namuna/Uslublar), History/Actions/Tool Presets 



(Tarixi/Xarakatlar/Asboblar tanlash), Layers/Channels/Paths 

(Кatlamlar/Кanallar/Кonturlar) i Character/Paragraph (Shrift/Abzats). 

 

Palitralar (palitry)  

Photoshop programmasida ko’p operatsiyalar palitralar orqali bajariladi ularni 

o’zaro aralashtirish xam mumkun. Istalgan palitrani ochish uchun esa Window 

(Okno) menyu komandasidan amalga oshiriladi. Belgilangan palitra boshqa  shu 

gkruxga kiruvchi politralardan eng yuqrida avtomatik tarizda joylashadi. 

Photoshop progrpmmasidan chikish: Windows  Operatsion dasturida bu dastur 

oynasini yopish uchun File > Exit (Fayl > Vyxod)menyusidan kursatilgan 

komandani tanlang yoki (Ctrl+Q) tugmalar kombinatsiyasini bosing 

Qatlamlar xuddi oyna qatlamlariga o’xshagandir faqat tasvir bo’lgan 

joylarigina ko’rinishga egadir. Xar bir qatlam uchun o’zining shffoflik darajasi 

bo’lib uni undan oldingi va kengi turgan qatlamlar bilan xamoxangligini moslash 

mumkin.  Qatlamlarni joylashish urnini almashtirish yoki ularni yagona qatlamga 

birlashtirish mumkin. Bir vaqtni o’zida xar xil qatlamlarda turgan tasvirni 

birgalikda o’zgartirish va bir qatlamda turgan rasmni faqat bir qismini o’zgartirish 

mumkin emas.  

Layers (Sloi) oynasida qatlamlar ustida turgan qatlamdan eng tagidagi 

katlamgacha aks etirilgan. Bunda fon qanlami oxirida joylashadi(1rasm). Xozirda 

belgilangan qatlam aktiv bo’lib ko’rinadi va faqat shu qatlam utida amallar bajarish 

mumkin.  

Istalgan qatlamni aktivlashtirish uchun tartiblanish oynasidan uni ustiga bosish 

kerak aktiv bo’lgan qatlam nomi programma nomi yonida akslanib turadi.  

 



 
 

Rasm.  Layers palitrasi 

Eslatma : Кatta xajimdagi tasvirlar bilan ishlayotganda bajarilib bo’lgan 

qatlamlarni birlashtirgan yoki o’chirib tashlash maqul shunda programma ishlash 

tezlik unimdorligi oshadi va tasvir xajmi kamayadi.   

Yangiqkatlam xosil kilish(Sozdanie novogo sloya)  

1. Eng avvalo 100% shaffof qatlam xosil qilish uchun Create New Layer  

tugmasi ustiga bosing.  

2. Agar qatlamni ulchamlarini o’zingiz beriokchi bo’lsangiz unda Alt, 

tugmasini bosib turgan xolda Create New Layer tugmasini bosing va qudagicha 

yul tuting:  

3.  Name (Imya) bo’limida katlamni nomini kiriting  Group With Previous 

Layer (Sgruppirovat s predudushim sloem) bo’limiga bayroqchani urnating. 

4. Layers (Sloi) palitrasidan kuz va muqylam ko’rinishidagi piktogrammalarga 

bayroqchani o’rnating.  

Mode (Rejim smeshivaniya) va Opacity (Neprozrachnost) parametrlaridan tasvir 

uchun Yangi parametrlarini berin(keynchalik bu parametrlar uzgartirilishi 

mumkin).   

5. OК tugmasini bosing. Yangi qatlam ishlatilayotgan qatlai ustida paydo 

bo’ladi.  

Eslatma: Tasvir xajmini kamaytirish uchun Layers (Sloi) menyusidan Palette 

Options (Optsii palitry) buyrug’ini tanlang va shu tasvirga tugri keladigan eng 

kichik xajmni tanlang.   



Belgilangan qismni qatlamga aylantirish(Prevraщenie vydelennoy oblasti v sloy) 

1. Belgilangan qismni xosil qiling.  

2. Layer > New > Layer Via Soru (Sloy > Novyy > Posredstvom 

kopirovaniya) menyusidan komandani bajaring(Ctrl+J tugmalari).  

3. tasvirni belgilangan qismini yulib olib tashlash uchun Layer > New > Layer 

Via Cut (Sloy >Novyy > Posredstvom vyrezaniya) komandasini bajaring(Ctrl+ 

Shift+J tugmalari).  

 

 

Rasm. 2.  Layer 1 xiralashtirilgan fondan xosil qilingan tasvir 

 

Qatlamni siljitish(Peremeщenie sloya)  Layers (Sloi) oynasida o’zgartirish 

kiritmokchi bulgan katlamni belgilang.  

1.  Move (Peremeshenie) asbobini aktivlashtiring(V klavishasi).  

2. Кatlamni kursorni ushlabturgan xolatda qatlamni siljiting(3 va 4rasm).  

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 Rasm. 3 . Amaldagi tasvir                       Rasm. 4. Matnli qatlamni      Move 

asbobi yordamida      

                                                                                       sititilishi     

Primechanie:  Auto Select Layer (Avtovydelenie sloya) mulimida bayrokcha 

turgan bulsa Move (Peremeщenie) asbobi yordamida tezda katlamni siljitish 

mumkin, ammo bu sijitish shaffofligi 50% dan kam bo’lgan  qatlamlar uchun 

ishlamaydi.   

Qatlamlar bilan ishlash uchun asboblar(Instrumenty dlya raboty so sloyami)  

Barcha asboblar qatlamlar bilan ishilaydi lekin bu bilan qatlamning 

shaffofsizligiga kata tasir o’tkazadi shuning uchun qatlam shaffofsizligini dimo 

nazorat qilib turing.  

Qatlamni uchirish(Udalenie sloya iz nabora)  

Qatlamni uchirishdan oldin uni nomini aktivligini tekshiring, va uni belgilab 

o’chirib tishlang.  

Qatlamga effektlatqkullash(Primenenie effektov sloya)  

Qatlamga quydagi maxsus effektlarni qulash mumkin: Drop Shadow (Otbrosit 

ten), Inner Shadow (Vnutrennyaya ten), Outer Glow (Vneshnee svechenie), 

Inner Glow (Vnutrennee svechenie), Bevel and Emboss (Skos i relef), Satin 

(Atlas), Color Overlay (Nalojenie tsveta), Gradient Overlay (Nalojenie 

gradienta), Pattern Overlay (Nalojenie uzora) va Stroke (Кayma). Effektlarni 

istalgan paytda istalgancha istalgan qatlamga qo’lash mumkin lekin qatlamni 

shaffofsizligini tekshirib turing.  



Eslatma  : Uslub(stili) va effektlarni bir biri bilan chalkashtirib yubormang. 

Uslub(Stil) – bu bir qancha qatlam effektlarini xamoxangligidir.  

Effektlar Layer Style (Stil sloya) muloqat oynasi orqali amalga oshiriladi.  

Effekt yonidagi galochka bu effektk shu qatlamga qo’lanilganini ko’rsatadi. 

qatlam effektlarini asosiy fon uchun qulash mumkun emas.   

Xama qatlamlarni birgalikda ishlatish(Zadeystvovanie vsex sloev)  

Agar optsiyalar panelida ko’ydagi asboblar ishlatilayotgan bo’lsa: Blur 

(Razmytie), Sharpen (Rezkost), Smudge (Palets), Paint Bucket (Vedro s 

kraskoy), Magic Eraser (Volshebnyy lastik) ili Magic Wand (Volshebnaya 

palochka) unda Use All Layers (Ispolzovat vse sloi) bo’limiga bayrokchani 

urnating shunda rang va boshqa o’lchamlar olinayotganda mavjud bo’lgan 

ranglarga yaqin bo’lgan tuslar birinchi navbatta ko’rinadi. Faqat aktiv bo’lgan 

qatlamda ranglar o’zgaradi 

Ikki qatlamni birlashtirish(Sliyanie dvux sloev)  

1. Birlashtirmokchi bo’lgan ikki qatlamdan qaysi birisi oldinro bklsa uni 

belgilang.  

2.  Layers (Sloi) menyusidan Merge Down (Slit s nijnim) komandasini 

belgilang yoki  Ctrl+E  tugmalarini birgalikda bosing . Aktiv qatlam o’zidan 

pastda turgan qatlam bilan birlashadi. Bir qancha belgilangan qatlamlarni 

birlashtirish uchun  Merge Layer Set (Slit nabor.sloev)komandasini tanlang.  

Qatlamlarni birlashtirish(Ob’edinenie sloev) 

Dikkat : Flatten Image (Ploskoe izobrajenie) komandasi qatlamlarni pastdan 

boshlab birlashtiradi va yashirilgan qatlamlarni avtomatik tarzda o’chiradi.  

Xama qatlamlar ko’rinib turganligiga amin bo’ling va qaysi qatlam aktiv bo’lishi 

muxim emas. Layers (Sloi) menyusidan Flatten Image (Ploskoe izobrajenie) 

komandasini tanlang. Agar programmada bekitilgan qatlamlar bo’lsa unda 

ogoxlantirish beriladi va OК tugmasini bosing va birlashtirishni davom etiring. 

Agarda pastki qatlamlarda ko’rinmaydigan nuqtalar bo’lsa ular oq ranga kiradi.   

QКatlamni uchirish(Udalenie sloya)  



Layers (Sloi) menyusidan keraksiz qatlam nomini tanlang. Sungra Trash 

(Кorzina) tugmasini bosing va Yes (Da) tugmasini xam bosing.  

Qatlamni uchirishni Yana bir usuli keraksiz qatlam nomi ustiga olib borib 

sichkonsani o’ng tugmasini bosing va menyudan Delete Layer (Udalit sloy) 

bo’limini tanlang xamda  Yes tugmasini bosing.  
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